
PosterJet 8.7 
Support Guide

Version 6  •  01.10.2015



 

 

Stand 01.10.2015

Support Guide 
 

 

Table of contents 
 

 

Chapter Title 

 

1 Installation Server .................................................................................... 3 

2 Installation Client ................................................................................... 12 

3 Client Server Architectur ........................................................................ 15 

4 Dongle Update / Upgrade ...................................................................... 18 

5 PPD setup .............................................................................................. 21 

6 Nesting with PosterJet ........................................................................... 23 

7 Setup a drying time ................................................................................ 26 

8 Profiling cut sheet media ........................................................................ 27 

9 Proofing media with PosterJet ............................................................... 28 

10 Create custom media profiles ................................................................ 30 

11 Resolve Server start issues ................................................................... 39 

12 Using the Job History ............................................................................. 40 

13 Working with templates .......................................................................... 43 

14 PosterJet under Windows 7, 8, and 10 .................................................. 49 

15 Advanced Epson B/W-print modes ........................................................ 51 

16 Integrate media profiles in PosterJet ..................................................... 53 

17 Color management in InDesign ............................................................. 55 

18 Setting energy saving options under Windows correctly ........................ 58 

19 Installation of PosterJet under Windows IIS ........................................... 61 

20 PosterJet and antivirus applications ...................................................... 73 

21 Overprinting with PosterJet .................................................................... 76 

22 Tri-Side-Cut plug-ins .............................................................................. 77 

23 PosterJet and Canon Spectro SU21 ...................................................... 81 

24 Database Backup and Restore ............................................................ 120 

25 Setting permissions for PPD printing and IIS ....................................... 137 

26 Liability ................................................................................................. 140 



 

 

Date 10.01.2015

Support Guide 
No. 1 

 

PosterJet Server Installation Guide 

 

1. Open the PosterJet Installation DVD or unzip the downloaded archive file(s) 
containing the PosterJet installation onto the hard drive of your PCs (preferably 
into the directory C:\Temp). 
Browse to the folder „Server Setup“ and open the folder suitable for the operating 
system you are using, either for Windows 32Bit or 64Bit. Click with the right 
mouse button onto the file Setup.exe and select the option „Run as 
Administrator“ from the context menu. 
 

 
 

2. The setup is started while necessary Microsoft libraries may be installed first. 
Continue by clicking the „Next“ button. 
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3. Carefully read the License Agreement and confirm that you wish to 
continue with the installation by selecting the option „I Agree“. Otherwise, 
if you don’t agree, please abort the installation by selecting the option „I 
Do Not Agree“. Click “Next” to continue. 
 

 
 

4. In case you have decided to continue the following window will appear. Here you 
can change the installation directory, if needed (e.g. limited hard drive space on 
drive C). Also select, if the PosterJet Server will later be available for all users that 
are logged in to your PC (option “Everyone”) or just by you (option “just me”). 
Continue with “Next”. 
 

 
 

5. Now confirm that you wish to proceed with the installation of the PosterJet V8 
Admin Tool by clicking the „Next“ button (see screenshot on next page). 
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6. After successful completion please click the „Close“ button to terminate part 1 of 
the PosterJet V8 Admin Tool installation. 
 

 
 

7. The PosterJet Server Installer will now open automatically and will guide you 
through the installation of the actual PosterJet Server. Please choose between 
„Express“ and „Custom“ installation. The Express method automatically installs 
the server with a set of pre-defined parameters, while the „Custom“ setup lets 
you modify these parameters before the installation. Continue with „Next“ to 
proceed (see screenshot on next page). 
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Hint: in case you did choose the Express installation, please continue 
with Step number 14. 
 

 
 

8. In case you did select the Custom installation you can now choose if the 
PosterJet Server will be hosted by the PosterJet Admin Tool or Windows IIS. We 
do recommend that you install the PosterJet Server under the PosterJet V8 
Server Hosting. The installation of the PosterJet Servers under Windows IIS is 
recommended for Windows Server operating systems only (e.g. Windows Server 
2012). Hint: changes of the port address while installing the PosterJet Server 
under the Windows IIS will result in a new IIS port address (port address of IIS is 
changed – also for other services). Please read the PosterJet Support Guide for 
further information concerning the installation under Windows IIS. Do not use this 
option, if you are not familiar with the concept of the Windows IIS or are not an 
experienced Windows user. 
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9. The following window will show the installation directory for the 
PosterJet Server (including the folders for the temporary files). Please 
modify the destination directory only, if you wish to install PosterJet on 
a different drive than C:\  (in case you there isn’t enough free space on 
hard drive C:\). Click “Next” to continue”. 
 

 
 

10. The next step allows you to change the number of printer plug-ins that you wish 
to install along with the PosterJet Server. Installing all plug-ins at once takes 
more to complete the installation. Printer plug-ins can also later be added by 
using the PosterJet Media Update utility from within the PosterJet Client. 
 

 
 
 

11. Continue with „Next“ to install necessary libraries and drivers. We recommend 
that you use the default options (see screenshot on next page). 
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12. You now get the possibility to select a custom certificate for the Client installation 
when using the Microsoft Click-Once Deployment method. Please do not select 
any other option than default shouldn’t you possess an appropriate certificate file 
and are familiar with such technology. Please click „Next“ to continue. 
 

 
 

13. Now click „Finish“ to start the actual Servers installation (see screenshot on next 
page). 
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As part of the software installation process, a new driver for the SafeNet HASP USB dongle will 
be installed if necessary. Please click „Next“ to confirm that you wish to proceed. 

 

 
 
 

14. Now accept the SafeNet license agreement and click „Next“ in order to continue 
with the installation (see screenshot on next page). 
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15. Click „Next“ one more time to begin the installation.  
 

 
 
 
Once the SafeNet has been installed click „Finish“ to proceed with the PosterJet 
Server installation. 
 
The last components are now installed, among them the PostGreSQL Database 
for PosterJet (see screenshot on next page). 
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Please wait until the process is completed and close the window by clicking „OK“.  
 

 

 

Once all components have been installed you will be asked to reboot the 
computer. Please confirm that you wish to reboot by clicking on “Yes” (except if 
you install PosterJet onto a Windows Server operating system and rebooting the 
system is not an option). 
 

 

 

 

The installation of the PosterJet Servers is now completed. Please proceed by 
installing the PosterJet Client. Use our Client Installation Guide that can be found 
on the PosterJet DVD or in the downloaded installation file(s). 
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PosterJet Client Installation Guide 

 

1. Open the PosterJet Installation DVD or unzip the downloaded archive file(s) 
containing the PosterJet installation onto the hard drive of your PCs (preferably 
into the directory C:\Temp). 

2. Browse to the folder „Client Setup“ and open the folder suitable for the operating 
system you are using, either for Windows 32Bit or 64Bit. Click with the right 
mouse button onto the file Setup.exe and select the option „Run as 
Administrator“ from the context menu. 
 

 
 

3. The PosterJet Client Setup Wizard appears. Now click „Next“ to continue . 
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4. Change the installation directory, if required (e.g. limited hard drive space on drive 
C). Also select, if the PosterJet Client will later be available for all users that are 
logged in to your PC (option “Everyone”) or just by you (option “just me”). Continue 
with “Next”. 
 

 
 

5. You are now asked to confirm that you wish to proceed with the installation. Click 
„Next“ to confirm and proceed. 
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6. Once the Client has successfully been installed a last window appears. Click 
„Close“ in order finish the installation. You can now run the PosterJet Client from 
the Start Menu of your Windows installation. 
 
Please read the PosterJet Support Guide for further information concerning the 
connection of remote Clients to a PosterJet Server or of local Clients to a 
PosterJet Server with a different port address. 
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PosterJet's Client / Server - Architecture 
 
PosterJet is a so called Client / Server Application. 
 
A PosterJet Server is a piece of software that provides the printers connected with printing data. 
The Server controls all queues (Main print queue, Nest queue) and processes all jobs before 
printing (Rastering, Scaling, Rotating, etc.). The PosterJet Server is running on one PC and is 
the administration center of the entire PosterJet printing environment. 
 
A PosterJEt Client is the interface of the PosterJet Server and a is the user interface for the 
operator. Using the PosterJet Client the operator performs all job editing. The Clients provides 
the operater with information on all queues and messages from the printer. The Client software 
may be installed on multiple computers. Multiple Client-PCs may be connected at a time via 
TCP/IP to the PosterJet Server.    
 
Some possible PosterJet printing environments 
 

 
 
 
 
 
 
 
 
 
 
 

15



 

 

Date 10.01.2015

Support Guide  
No. 3 

 
 
 
 
 

  
 
Minimal configuration. PosterJet Server and a PosterJet Client are installed on the same 
computer. The printer is connected to the computer via TCP/IP crosslink or USB 2.0 (depends 
on printer) 
 
 

 
 
PosterJet Server and a PosterJet Client are installed on the same computer. The printer is 
connected to the computer via TCP/IP . Another Client is installed on another PC. A TCP/IP 
switch is required. 
 
 

 
 
PosterJet Server and a PosterJet Client are installed on the same computer. The printer is 
connected to the computer via USB. Another Client is installed on another PC. A TCP/IP switch 
is recommended. 
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Complex setup with one PosterJet Server. PosterJet Server and a PosterJet Client are installed 
on the same computer. Additional Client is are installed on additional PCs. Four printers are 
connected via TCP/IP with the PosterJet Server PC. One printer is connected to the PosterJet 
Server PC via USB. A TCP/IP switch is required. A Gigabit switch is recommended. The 
computer that hosts the PosterJet Server at minimum a 
3 GHz CPU and 4 GB of RAM is recommended. 
 
 
 
IMPORTANT: 
It is not necessary to run PosterJet on a Server Operating System! 
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PosterJet 8.7 Update or Upgrade 
 
Before updating a previous PosterJet release to version 8.7 it is important to check the 
current version number: 
 

- Any PosterJet version 6.x or previous: cannot be updated to version 8.7. A new 
copy of PosterJet needs to be purchased. 

- PosterJet version 7 and above: can be updated via internet and email. See 
procedure below. 

 
 
How can the version number be checked? The easiest way is to write an email to our 
support team with your / the customer’s dongle number. Once we have identified the 
version number we will reply by email. Please use the following email address to request 
information on the dongle version: info@posterjet.de 
 
How can I identify if the dongle needs to be replaced? Over the years the dongle 
technology has changed a few times. Only green HASP HL or black HASP TIME dongles 
can be updated for version 8. They look like this: 
 
 
 

    Hasp HL Dongle (short and green) that can be updated (only used in 
version 7 and above). Number of dongle is usually engraved on the front. 

 
 

Hasp HL Time Dongle (black) can be updated (only used in version 8 
and above). 

 
 
All the following dongles cannot be updated and must be replaced: 
 

 Older Hasp parallel key (white or red). Update not possible. 
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     Older Rainbow USB key (purple - used in version 5 and 6). 
             Update not possible. 
 
 

Older Hasp 4 USB key (dark purple used in version 6). 
                      Update not possible. 
 
 

 
1) How to update a PosterJet version 7.X to version 8.7? 

 
A) You / your customer have gotten an old dongle.  You need to purchase a new 

dongle and send the old one back. There is no other way of updating PosterJet 
with any older dongle to version 8.7. 
 

B) You / your customer have gotten a newer green HASP HL dongle that can be 
updated. 
 
First, you / your customer need to install PosterJet 8.7 after you have 
uninstalled PosterJet 7. Open the “Tools” menu in the Client window of the new 
version and select “Dongle upgrader…” in order to create a so called “Upgrade 
file”.  
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The following window appears: 
 
 

 
 
Proceedure 
 
First click button "Generate upgrade file". This button is used to generate a 
dongle specific file (so called Upgrade file) that needs to be send via email to 
update@posterjet.de. The directory in which the file will be placed is shown 
below in the field “Upgrade file” or can automatically be opened by a click on 
the button “Location”. When sending your email make sure you mention what 
type of update or upgrade you wish to perform and include your purchase 
order, if applicable. 
 
 
Once you receive the so called “Unlock file” from Eisfeld click the button 
“Select unlock file”. Select the file with the extension *.v2c that you received by 
email and click the button “Upgrade” that will now become visible.  
 
Wait until PosterJet confirms that the update was successful. 
 

2) How to upgrade new features or printers to PosterJet version 8.7? 
 

Follow the procedure as described in section 1 B, as it is the same procedure as 
updating PosterJet from version 7 to 8.7. 
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Install a virtual PosterJet Windows printer driver (short version) 
 
 
In order to print from any application - like MS Powerpoint or MS Word - directly into 
PosterJet, a virtual Windows printer has to be installed first. Please follow the instructions 
in order to install a virtual PosterJet printer under Windows: 
 

1. Go to Windows “Start” and select “Printer and fax devices”. Then choose “Add 
printer”. 

2. The printer installation opens. Click on “Next” to continue. 

3. Choose “local printer” and click “Next” again. 

4. Under “Use following port” please choose „PosterJetV8: (Virtual printer port for 
PosterJet V 8)“, then click on “Next”. 

5. Click “Have disc” and search for the “PPD” directory on the PosterJet Installation 
DVD, or locate the PPD folder inside your download folder, if you have 
downloaded PosterJet from our servers. Select the folder with your operating 
system and language from within the PPD folder. Then open the respective 
“PosterJet.inf” file and confirm with “OK”. 

6. Select your printer model from the list and continue with next. 

7. In the next dialogue window you can change the name of your virtual printer, if you 
like to. Select, if you want it to be the default printer and click “Next”. 

8. Choose if you wish to share the virtual PosterJet printer in your network. If you 
choose so, you will have to name the printer for identification in your network. Click 
“Next”. 

9. Now you can decide to print a test page or not. Click “Next”. 

10. The last dialogue window opens. Information on the installation is shown. Click 
“finish” to complete the installation. 

11. Before you can start printing from an application directly into one of the PosterJet 
queues you must download the file „PosterJet Tool Ver2.exe“ and run it as an 
administrator in order to set the correct permissions under Windows (otherwise 
jobs will not be forwarded from the Windows print queue to the PosterJet queue).  
The toll can be found on our website under: 

http://www.posterjet.com/mehr-downloads/ under „PosterJet PPD und IIS Installer“ 

Run the tool after you have closed the PosterJet Client and Server. Choose your 
virtuellen PosterJet printer from the drop down menu under „Select virtual Printer 
(on port „PosterJetV8“)“. Now click the button „PPD / PosterJet“ and wait the the 
procedure is completed. It is absolutely necessary that you restart your PC so that 
the changes become active. 
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From now on you can print from any Windows (or Mac) application directly into the 
PosterJet main or nest queue. The virtual PosterJet printer will generate 100% 
compatible PostScript data and will forward it directly to PosterJet. There, you can 
modify or print the file like any other TIF, JPG or PDF file. 

 
Hint: in order to use this functionality, you must have the PostScript module enabled in 
PosterJet (either buy a PS edition of PosterJet or purchase the PostScript module 
separately). 
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Nesting with PosterJet 
 
The function nesting helps you to print your files on a medium without wasting space. 
Depending on the settings PosterJet nests the files and even rotates them to fit best. 
With setting the maculature you avoid the wastage of paper and increase your 
productivity. 
 
Nest attribute settings: 
 

 
 
 
Nest Type 
 

1. Best fit 
 

The files are nested to use the size of the media to full capacity 
 

2. Best cut across 
 

The files are nested for the best possible cut on the X-axis. 
 

3. Best cut 
 

The files are nested for the best possible cut on the X- and Y-axis. 
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Time out every 
Here you can set the time PosterJet waits before sending the nesting job into the main 
queue. When this box is activated and there are not enough files to nest on the given 
maximum wastage the files are being send into the main queue after the time out, 
though.  
 
Maximum wastage 
When the “time out every” box is not activated the files are being automatically send to 
the main queue when the maximum wastage is falling below the given value and the 
nesting queue is started. Please note that if the time out box is set to a value and is 
expired the files are being send to the main queue without minding the maximum 
wastage. 
 
Minimum Length 
Here you can set a minimal length, which defines when the files are being sent to the 
main queue when this value is reached. E.g. if you give a length of 30”, the files are being 
send to the main queue, when they reach the length of 30” through nesting. 
 
Nest gap 
Here you can set a gap between the single files of a nesting job. 
 
Cutter (if appropriate) 
Here you can set the cutter, if the medium allows to be cut. Now the cutter is used after 
this nesting job. 
 
Allow image rotation, if needed 
If this box is activated PosterJet automatically rotates the files to assure that less space is 
wasted. 
 
Criteria 
These boxes show you which medium is used, which size the roll/page has, which 
resolution and print quality have been chosen. 
 
 
 

Image: sample nest job 
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PosterJet 8 comes with a powerful nest preview and editor which allows the viewing and 
modification of nested jobs before printing. In this preview and editing tool jobs can be 
previewed, moved, rotated, deleted or centered just before they will be printed. 
 
The nest preview (editor) is activated by a right mouse click on the nest job. Select the 
option “Nest editor…” from the context menu. 
 

 
 
 
This option is also available for jobs with multiple copies in layout mode. 
 

 
 
 
Hint: files that are moved in their position will snap to invisible magnetic guide lines. If you 
wish to move the files freely around the paper area please hold the ALT-key (and keep it 
down) while moving one or multiple files. 
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Setting a drying time 
 
Sometimes it’s needed to set a drying time to e.g. protect your prints from damage. This 
prevents the cutting from a new printed canvas directly after printing. The print can dry 
during the drying time before the medium is cut. The damage of the wet print is 
prevented. 
 
To set the drying time open the “Tools” tab in PosterJet and navigate to “Media 
Manager”. Open the tree of the media you want to set the drying time for (F6 or clicking 
the “+”) and choose one of the print modes. 
 

 
 
 
You now can set the drying time under “Drying time”. If you need to slow down the 
printing process for a specific media you may want to choose the option “Drying time 
while printing”. Please note that once a drying time is set it is always being used when 
printing with this print mode on this media. 
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Creating ICC profiles for cut sheet media 
 
When trying to create ICC profiles for cut sheets in PosterJet 8, the following problem 
may occur: in step 6 of PosterJets MediaManager (Print test chart) the test chart is not 
prepared and set for the media set in the Multi Purpose Tray or Cassette but rather for 
the media in the Roll selection. This means that the PosterJet MediaManager will place 
any test chart print job automatically on roll media (changing any previous settings). To 
still print the test chart on a cut sheet, please follow these instructions: 
 
 

1. Print your test chart as usual with the PosterJet Assistant, but make sure, the main 
queue is stopped before launching the job. 

2. Switch to the „Media Settings“ tab of the PosterJet main window (in the 
background) and select the media you wish to profile under Cassette or Multi-
Purpose Tray. Confirm your selection by a click on the button with the green tick. 
Best, if you select „Unloaded“ in the Roll Unit section before.  

3. Now select the test chart job in the main queue with one left mouse click. Click 
onto the job with the right mouse button and select the option „Scale to current 
page size“ from the drop down menu.  

4. The test chart has now been placed on your cut sheet media. Maybe you wish to 
control if the job has not been scaled to less than 100%. For this, please open the 
job and control the size and rotation in the Job Submission window of PosterJet 8. 

5. Confirm your settings by a click on the „Submit job“-button (green tick). Once you 
start the main queue your test chart will be printed to the cut sheet loaded in the 
printer.  
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Proofing with PosterJet 8  
 
Next to photorealistic output and fine art prints PosterJet 8 is capable to create FOGRA 
compliant proofs on almost any supported printer. For this purpose, ICC input profiles, 
based on FOGRA data, and settings in the „Colour“ tab of PosterJet 8 are required.  
 
With PosterJet 8 the FOGRA media wedge* can be printed with different proof settings 
for various printing scenarios, in order to measure and analyze its data. This is done 
especially to evaluate the quality of an output profile (the lower the Delta E deviation from 
the reference value, the better the output profile). On top of this, one can use the media 
wedge to analyze changes in the print conditions over time.  
 
 

 
 
 
Before you start, please download the reference profiles from the ECI website for the 
offset print environments that you would like to simulate: 
http://www.eci.org/doku.php?id=de:downloads 
 
If you wish to create a proof based on the ISO Standard 12647-2:2004/Amd 1 (FOGRA 
39L) please install the „ISOcoated_v2_eci.icc“ profile under Windows while the PosterJet 
server is switched off. First download and unzip the „ECI_Offset_2008.ZIP“ file from the 
ECI website. Select the file „ISOcoated_v2_eci.icc“, and click it with the right mouse 
button. Select the option “Install profile” from the drop down menu. This procedure can be 
repeated for all other reference profiles, whether from ECI or not, that you wish to install. 
By the way: install means that the profiles are automatically copied to the following 
Windows system directory: C:\Windows\system32\spool\drivers\color\. 
 
Once PosterJet is re-started, it will read all the profiles located in this directory.  
 
All that is left to create proof prints with PosterJet 8 is to make the right settings in the 
“Colour” tab of the submission window (see screen shot below). 
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Image: „Colour“ tab of PosterJet submission window 
 
Particularities: 
 

- When working with RGB output profiles (printer receives RGB Contone data) only 
RGB simulation profiles can be selected. We from PosterJet recommend RGB 
Contone for all Canon and Epson printers, as this method guarantees the best 
results. Anyway, we do not recommend the use of any RGB simulation profile for 
printing. That makes no sense. 

- The above shown settings are only valid, when printing pure CMYK files. Once 
files are printed with CMYK and RGB data, we recommend to switch to 
“Advanced...” settings and to set the rendering intent for CMYK (Absolute) and 
RGB (Perceptual) separately.  

 
The media wedge should be analysed using a suitable tool (not part of PosterJet 
software). 
 
 
* The FOGRA media wedge is not part of PosterJet 8 either and has to be purchased separately. 
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Creating custom media profiles using PosterJet 8.7 
 
It is easy to create custom media profiles for Canon imagePROGRAF printers using 
PosterJet 8. To do this the following requirements must be fulfilled: 
  

- You own a color measurement device that is supported by PosterJet 8 (Spectral 
photometer): X-Rite Eye-One Pro, X-Rite Eye-One iO, X-Rite ICColor, X-Rite DTP 
70, DTP 45, DTP 20, GretagMacbeth SpectroScan. 

- You own the PosterJet profiling module. 
 

Please proceed as follows: 
 
Launch the PosterJet 8 Media Manager (Menu „Tools“ -> „Media Manager…“). Choose 
the measuring device from the menu „Tools“ -> „Choose measuring device…“. Click the 
"+" button to create a new media. 
 

 
 
 
The profiling wizard will now be launched. 
 
 
 
 
 

30



 

 

Date 10.01.2015

Support Guide 
No. 10 

 
 

 
 
Click „Next“. Step 1 of 8 of the profiling wizard will be launched. 
 

 
 
Step 1: Enter a meaningful name into the "Media Name" field. This media name will 
appear in the PosterJet Media Settings afterwards. It is recommended to incorporate 
brand and product description (or order number) into the new media name. Select the 
media type corresponding to the media you would like to profile. 
Important: the selection of a dedicated media type indicates the black ink type (Matte 
black or Photo black), ink limit, and print quality. If you have any questions regarding the 
proper 
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media type, please ask the media manufacturer for more information. The Media type 
selected is also the front panel setting that must be selected in the printer during the 
loading of the media.  
 
Click the „Next“ button. 
 

 
 
Step 2: Print quality selection. A PosterJet media may contain multiple print qualities. For 
every print quality a dedicated media ICC profile must be created. The complete workflow 
described in this document must be performed for every single ICC profile (= print mode).  
 
For the Canon iPF printers we highly recommend the Dithering option „Contone RGB“. 
Choose the desired resolution from the "Resolution" drop down list. From the "Print 
quality" drop down list choose the desired print quality. The combination of these three 
parameters represents a PosterJet print quality (a single print mode for a single media). 
 
Complete step 2 by clicking the "Next" button. 
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You are now directly guided to step 6: Selecting and printing a test chart. 
 
Select the desired test chart and click on the "Print test chart" button. Depending on the 
measuring device the printed test chart will look different. To print the test chart please 
make sure that the main print queue of PosterJet is running and the respective media is 
loaded into the printer. PosterJet will now print the test chart. 
Click the "Next" button. The measuring device will now be calibrated. In step 7 you will be 
asked to measure the test chart. After measuring the chart click the "Next" button. 
 

 
 
 

Important note: 
 
In case you are using an Eye-One 
measuring device please make sure 
you are always measuring from left 
to right and never backwards. 
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Step 8: Creating the new profile. Only modify the default settings if you are familiar with 
the options provided. It is recommended not to change the default settings. Click "Next" 
to create the new profile. 
 

 
 
You will be asked to enter a name for the new profile. Otherwise you can accept the 
proposed profile name by clicking the "OK" button.  
 

 
 
The new profile will now be calculated 
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The profile was created successfully and stored on the hard disc. Close the wizard by 
clicking the "Finish" button. 
 
We recommend you quickly check the new profile for errors. Please click with the right 
mouse button onto the print mode in MediaManager that you just profiled and select the 
option ‘Profile viewer’ from the context menu. Check that the new profile is correct and 
does not show any errors in the geometry.  
 

 
 
The new profile is now available on the PosterJet Media Settings tab. 
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PosterJet 8 media profile service 
 
In the case you do not have access to a measuring device and do not own a profiling 
software but do own the PosterJet Linearization module we are proposing to create the 
profile for you through our profile creation service. We will charge 120,- € for every media 
profile with one print mode (one ICC profile). 
 
To order your own media profile proceed as follows: 
 
Launch the PosterJet „Media Update“ from the „Tools“ menu and select the „NullDevice“ 
measuring device.  
 

 
 
Click on "Download updates". After downloading the file close the update dialog window. 
Launch the Media Manager from the "Tools" menu of PosterJet and select the option 
"Select measuring device" from the "Tools" menu.  
 

 
 
Select NullDevice and click „OK“. 
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Start the media creation process as described above. Follow the workshop until the test 
chart selection step. Choose the chart „TC9.18 RGB iSis(A4).tif“. 
 

   
 
 
Print the test chart as described above and send us the printed test chart via mail. Please 
make sure, that the test chart print out is not damaged or folded. The print out should not 
be exposed to direct sunlight or other UV radiation. Let dry the print out for about an hour 
before packing it. For transportation please use a tube made out of card board or plastic. 
Do not fold the printed test chart. Please let us know the media name and the desired 
print mode for the ICC profile. 
 
You will receive an e-mail containing the ICC profile from us. To integrate the profile into 
PosterJet launch the Media Manager and press the F6 key to unfold the media tree.  
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Right-click on the print mode you would like to equip with the new profile and select 
"Change ICC profile..." 
 

 
 
 
From the file browser dialog window select the new profile you received from us. Click the 
"Open" button. The new profile will now be implemented into the PosterJet media 
management and is available for printing via the Media Settings tab of PosterJet. 
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PosterJet Server does not start 
 
In rare cases it may happen that the PosterJet Server will not start – even if the TCP/IP 
Port has been changed or the software has completed been re-installed. The purple 
Server Icon in the Windows taskbar appears, but the Server isn’t starting (Start-button 
jumps back). 
 
 

  
 
 
In this case it is highly probable that the PostgreSQL database software is not running 
correctly. Please check that the database software is running correctly or reboot the PC. 
 
Please contact our support at support@posterjet.de should you still encounter issues 
with the server start or read Support Guide No. 24 for further instructions. 
 

If the start button 
is visible it means 
that the PosterJet 
Servers failed to 
start correctly. 
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Reprinting jobs from the Job History onto a different media 
 
As soon as a job is reprinted from the Job History onto a different media than originally 
selected the message ‘Media not loaded‘ will appear. Please check entry under ‘media 
settings‘ in the status bar of the main queue. The job has been paused and PosterJet 8 
will not reprint it automatically. 
 
Example: 
 
The job ‘Winter.jpg‘ was originally printed onto ‘Adhesive Matt Stretch Vinyl 270my‘. With 
a mouse click on the ‘Submit‘-button (see red circle) in the Job History the job can be 
resend to the main queue for reprinting. 
 

 
 
 
If, in the meantime, the media has been changed in the printer and in the PosterJet tab 
‘Media settings‘, e.g. from ‘Adhesive Matt Stretch Vinyl 270my‘ to ‘Matt Coated Paper 
140g‘, 
 

 
 
the resubmitted job in the main queue will be paused and the status message changes 
from ‘Ready‘ to ‘Waiting for media‘. 
 

 
 

40



 

 

Date 10.01.2015

Support Guide 
No. 12 

 
 
 
 
To print the job anyway with the correct settings for Matt Coated Paper 140g proceed as 
follows: 
 

- Double click the resubmitted job in the main queue with the left mouse button to 
open the PosterJet submission window. 

- Change to the tab ‘Printer‘ and select the currently loaded media from the media 
list (in this case: Matt Coated Paper 140g *). Hint: the currently loaded media is 
marked by a star. 
 

  
 

- The job can now be submitted by clicking onto the green submission button 
 

  
 

- Eventually, you will have to adjust the scaling of the job if printed onto a different 
roll size. Attention: is the new roll (Matt Coated) smaller than the roll that was 
originally used (Stretch Vinyl) you must confirm manually to rescale the job to the 
new roll size (job will now be reduced in size!). For this, click with the right mouse 
button onto the job in the main queue and select the option ‘Scale to current page 
size…‘  
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- This adjustment affects the size of the job and will adjust it to the current roll size. 
You may at any time change the size manually by opening the job in the 
submission window (double click the job entry with left mouse button to open 
submission window). Before printing always check if the job is at exactly the size 
needed when performing the Scale to current page size option.  
 

- The job is now ready for printing. To start printing just start the main queue by 
clicking the Start-button. 
 
 

 
 
 

 
 

42



 

 

Date 10.01.2015

Support Guide 
No. 13 

 
 
Working with PosterJet templates 
 
In order to increase productivity even further when submitting jobs in PosterJet 8 
templates can be generated and applied to transfer a wide range of settings to a single or 
multiple print jobs with only one mouse click. Job templates are files that contain all job 
parameters like scaling, number of copies, borders, color management settings etc. Job 
templates can be applied to any file and for any kind of job in order to facilitate job 
submission even further. 
 
Example: 
 
You wish to submit a series of jobs with identical settings without having to open each job 
individually and make all the necessary settings. Here, PosterJets job templates are the 
right tool. Once created, one or multiple jobs can be selected and with only one mouse 
click a specific template can be applied, changing all parameters of the job(s) to the one 
in the template.  
 
To create a job template please proceed as follows: 
 
Open the „Media settings“ tab of the PosterJet main window. Select „Unloaded“ from the 
media list and confirm your selection by clicking onto the green ‘Submit’-button. With this 
you ensure that your template will later work with any media in your media list. 
   

 
 
Now select a file (any) by clicking on the green ‘Plus’-button. The same way you would 
submit a regular print job to the main queue.  
 

 
 
You will now be asked if you wish to continue, since no media was selected (“loaded”). 
Please confirm with ‘Yes‘ (see screenshot on page 2). 
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The job submission window will open as usual. Please set the needed value for any 
setting that you wish to change in later jobs. Change things like the value for scaling, 
number of copies, borders, rotation, alignment, color settings, type of crop marks, cutter 
yes/no, layout yes/no, and many more. Provided that you leave a value unchanged, 
PosterJet will later use the default value for this setting. 
 
Example for the alteration of values in the ‘Layout‘ tab of the PosterJet submission 
widow. 
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You are free to change any setting in the PosterJet submission window. Once you have 
completed all your entries, choose the option ‘save template’ from the ‘File’ menu of the 
submission window. 
 
 

  
 
 
A new window will open and you will be asked to enter a name for the newly created 
template. We recommend you use a name that perfectly describes the template settings, 
so you will remember them once you wish to use them in the future. 
 

  
 
Click the OK-button to confirm your entry and to save the template. 
 
If you now wish to print a series of jobs with identical settings proceed as follows: 
 

- Select a media in the ‘Media settings’ tab of the PosterJet main window on which 
you wish to print the jobs (e.g. Matt Coated Paper 120gr). 

- Select the file(s) that you wish to print (you can add multiple files to the PosterJet 
main or nest queue via drag & drop. Or just click onto the ‘Add’-button in the 
queue and select multiple jobs from the file manager window with the SHIFT- or 
CTRL-key (exactly like in your Windows explorer). 
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As soon as all jobs have been added to the queue select one or multiple entries (if 
wished even all). 
 

 
 
Use the right mouse button to open the context menu and select the option ‘Apply 
template’ 
 

  
 
Select a template and confirm to apply it to the selected jobs by clicking the ‘OK’-button.  

Selection of multiple files 
for printing in PosterJet 
using the mouse and the 
CTRL-key (on German 
Windows OS). 
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Hint: PosterJet ‘Hot Folder‘ work in perfect harmony with job templates. Any PosterJet 
Hot Folder can have a job template linked to it. This feature allows the installation of a 
fully automated production (also on multiple printers!). 
 
In PosterJet you will also find a Template Manager that allows you to store, delete, or edit 
your templates. The Template Manager can be found in the ‘Tools’ menu of the main 
window. In addition so called color templates can be created that will only modify the 
color settings of jobs (same settings as in ‘Color‘ tab of PosterJets submission window) 
but leave all other parameters to default. 
 

  
 
or 
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Hint: you can make any template your standard one for your complete workflow (all files 
that are added to PosterJet for printing will automatically be changes to the values stored 
in the template. Example: cutter always ‘off’). For this, open the printer settings in the 
printer list of the main window (double click on printer in list on left side of the window).  
 

  double click here 
 
 
Change to the ‘Default’ tab and select any template to become your new job or color 
standard. 
 
 

  
 
From now on all jobs added to the main or nest queue will automatically be changed to 
the settings defined in the template selected above. Of course, you will have the flexibility 
to still modify any setting individually at a later stage once the jobs are in the main or nest 
queue (double click, open job submission window and change setting individually). 
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PosterJet 8.7 and Windows 7, 8 or 10 
 
PosterJet 8.7 runs perfectly under all Windows OS (Windows XP or higher) if the 
following settings are considered during installation: 
 

1. Please install PosterJet 8.7 by right-clicking the “Setup.exe” from your PosterJet 
installation DVD or the locally unzipped folder of your download and choose “Run 
as administrator”. 

 
2. Install PosterJet as described in Support Guide No. 1 and 2. 

 
3. Run PosterJet 8.7 Admin Tool always as administrator (especially as long as the 

Windows User Account Control is activated). This can be done by right-clicking the 
Server and Client application and choosing “Run this program as an administrator” 
under “Properties” -> “Compatibility” -> “Privilege Level”. Click on “Apply” and 
“OK”. You will have to restart the Admin Tool if activated before the changes 
become active. 
 

 
 

The PosterJet Admin Tool application can be found here:  
 
C:\Program Files\Eisfeld Datentechnik\PosterJet V8 Admin Tool\PosterJetAdmin.exe 
 
The PosterJet Client application here: 
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C:\Program Files\Eisfeld Datentechnik\PosterJet V8 Client\PosterJetClient.exe 
 
or  
 

C:\Program Files (x86)\Eisfeld Datentechnik\PosterJet V8 Client\PosterJetClient.exe 
 

4. Printing documents through the virtual printer driver (PPD) requires the use of our 
software tool called “PosterJet Tool Ver2.exe”. Please read Support Guide No. 5 
for further instructions. 
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Professional black/white output with Epson Stylus Pro printer 
 
With PosterJet 8.5 we have created the possibility for you to produce professional black 
and white prints from any file without prior conversion on Epson Stylus Pro printer. No 
matter if you take a color image or a PDF file, PosterJet 8.5 will - on your request - do the 
conversion automatically for you. In addition you have a number of choices to create a 
variety of black and white prints (e.g. like Sepia or Duotone). To print files in black and 
white proceed as follows: open the job and go to the printer tab in the job submission 
window. Select a print quality ending with “….Adv. BW Photo“.  
 

 
 
 
You will find the different settings for your BW prints in the PosterJet Media Manager. 
Before you print your file, open the PosterJet Media Manager (menu “Tools” from main 
queue). Select your media and open the media tree to access the print modes by 
pressing F6 (or click the little plus buttons). Click on the print mode you will be using. You 
will now see the „ABWP Color Controls“ you might want to change.  
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Notice: 
 

- Not all paper types do have Adv. BW Photo print modes. 
 

- Not all Epson Stylus Pro printer do support Adv. BW Photo print modes. 
 

- A preview of the later results is unfortunately not possible. We recommend that 
you perform a test print first in order to check the effect of your changes to your 
output. 

-  
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Installation of ICC or media profiles in PosterJet 8.7 
 

1) You wish to install an Input profile in PosterJet 8.7? Just proceed as follows: 
 

Click with the right mouse button onto an ICC profile that you wish to install. Select 
the option “Install ICC Profile”.  
 

 
 
Restart PosterJet (Server and Client). The new profile is now available within 
PosterJet. You will find it in the „Colour“-tab of the PosterJet Submission window 
under „Input profiles“. 
  

 
 
 

53



 

 

Date 10.01.2015

Support Guide 
No. 16 

 
2) There are two options to install new media in PosterJet 8.7: 

 
- Install new media through PosterJet Media Update Service via internet. For this, 

please go to the “Tools” menu of the main Client window and select the option 
“Media Update…”. 
PosterJet will now connect to the PosterJet Live Update Server, if an internet 
connection exists. The Update Service will list all updated or new media.  

  

 
 

Select the media you wish to download. Click button “Download updates“. 
PosterJet will install all selected media automatically. These can be used 
immediately, without the need to restart PosterJet. 
 

- If you wish to install a new media from a ZIP file that you obtained via email or 
through download from our website, chose the option „Update from file“ from the 
window above. You will be asked to select the ZIP file. Click the “Open” button in 
the dialog box and the media file(s) will be installed automatically. 
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3) How to import and ICC media profile to an existing media? 

 
- Open the PosterJet „Media Manager“ from the Tools“ menu of the PosterJet 

Client. Select the media for which you wish to import the ICC file. First open the 
media tree by a click onto the F6-key of your keyboard. Select the corresponding 
print mode using the right mouse button and select the option „Change ICC 
profile” from the context menu.  

 

 
 
Select the IIC profile in the explorer window and click “OK” to confirm your 
selection. 
 

 

PosterJet will from now on 
use the new ICC profile for 
the specified paper and 
print mode. 
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Color management with Adobe Creative Suite 
 
When exporting files from components of Adobe’s Creative Suite you must ensure that 
the correct color management settings are chosen in the preferences, otherwise you will 
obtain wrong output (wrong colors, or too dark colors etc.). 
 
To check that you have selected the correct settings please perform the following little 
test: 
 
Open a file in Photoshop that you know well and save it as Tiff format. Don’t forget to 
save it with the option to embed the ICC profile. Now print the file with PosterJet. 
 
Import the same file in InDesign. Save the file as PDF and print it with PosterJet. 
 
If the prints differ in color the settings in InDesign are incorrect and therefore have to be 
changed. How to change color settings in InDesign: 
 

1. Choose the entry „Output“ -> „Color Conversion“ -> „No Color Conversion“ in the 
export window. 

 

 
 
 
 
 
 
 

56



 

 

Date 10.01.2015

Support Guide 
No. 17 

 
2. Choose the entry „Include All RGB and Tagged Source CMYK Profiles“ under 

 “Output“ -> „Profile Inclusion Policy“ in the export window.  
 

 
 
 
Now save these settings and reuse them or define these settings as standard settings. 
 
Try to print the new PDF again and check if both your prints (Photoshop and InDesign) 
now match.  

-  
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PosterJet 8.7 and Windows Power Save Options  
 
If Windows 7, 8 or 10 is operated with standard settings it will switch to sleep mode 
(power save mode) after a short inactive period. If PosterJet is running, it is sometimes 
possible that the PosterJet client loses the connection to the PosterJet server. In this 
case the PosterJet client has to be restarted to re-connect to the PosterJet server. 
 
To avoid this please adjust the power options under Windows. 
 

1. Go to “Start” -> “Control Panel” 
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2. Choose „All Control Panel Items”. 

 

 
 
 

3. Choose „Power Options“. 
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4. Choose „Show additional plans“. 
 

 
 
 

5. Choose „High Performance“ from the drop down menu. 
 

 
 
 
PosterJet should work as required. 
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PosterJet installation under Windows Internet Information Services 
 
PosterJet 8.7 Server can be hosted as a web service under Windows Internet 
Information Services (available on any Windows OS, but mainly designed for server 
operating systems).  
 
Requirements: 

- Administration privileges under Windows 
- PosterJet 8.7 Installation DVD 
- PosterJet Tool Ver2.exe application (also available as download under: 

http://www.posterjet.com/mehr-downloads/   ->  PosterJet PPD and IIS Installer) 
 
Step 1  
Install PosterJet Server and Client under Windows. Do not restart the PC at this 
moment. 
 
Step 2 
Run the application „PosterJet Tool Ver2.exe“ by right clicking the entry and selecting 
the option „Run as Administrator“ from the context menu. 
 

 
 
The following window appears: 
 

  
 

Click „IIS Activate“, if the 
Windows Internet Information 
Services have not yet been 
installed. 
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Click the „OK“-button to start the installation of the Windows IIS. An internet connection 
may be required for Windows to download the latest system files. 
 

  
 
The following window appears during the installation. 
 

  
 
Please wait until the installation is completed. The installation may take a few minutes 
depending on the speed of the computer. Once finished, you will be asked to reboot the 
PC.  
 

 
 
Complete the process by first clicking onto the „OK“-button and then by closing the 
„PosterJet Tool ver 2.0“ window. Restart the PC (is absolutely required). 
 
Step 3 
PosterJet must now be registered under the Internet Information Services (a new 
Application Pool must be created, a new Default Web Site must be added, and some 
important parameters must be set along with necessary permissions. All tasks can 
easily be performed using the „PosterJet Tool Ver2.exe“ application. It is important that 
you run the „PosterJet Tool Ver2.exe“ as an administrator (right mouse click onto 
application to open the context menu). 
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The following window appears:  
 

  
 
Click the „IIS / PosterJet“-button in order to continue with the registration of PosterJet 
under the IIS.  
 
The following window appears: 
 

 
 
Click „OK“ to proceed. Please wait until the registration is completed. The process may 
take a few minutes. 
 

  
 
 

Creating Application Pool, 
adding the Default Web Site, 
and setting the necessary 
parameters and permissions 
with a click onto the „IIS / 
PosterJet“-button. 
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Once the registration is completed you will be asked to reboot the PC again. Click “OK” 
to close the window.  
 

 
 
Exit the application „PosterJet Tool Ver 2.0“ by clicking the “Close” button and restart 
the PC so that the changes can become effective. 
 

 
 
Once the PC has been restarted open the PosterJet administration utility. Stop the 
PosterJet Server by a click onto the Stop-button. 
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Now switch the option for „Hostet on“ from „PosterJet V8 Hosting“ to „Internet 
Information Service (IIS)“. 
 

 
 
Exit the PosterJet administration utility. 
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Click „Yes“ to close the application. 
 

 
 
Remove the PosterJet administration utility from the Windows Startup Menu. The 
application will not be needed any longer since the PosterJet Server will behosted under 
the IIS. Open the following folder in order to remove the autostart entry for PosterJet 
Server under Windows: 
 
C::\"Users"  ->  "CurrentUser"  -> "AppData"  ->  "Roaming"  ->  "Microsoft"  ->  
"Windows"   ->  "Startmenu"  ->  "Applications"  ->  "Autostart" 
 
Delete the link for the PosterJet Server from the list.  
 
Hint: typically, the Windows auto start folder is hidden and needs to be made visible (for 
more information check Windows Explorer folder options).  
 
Proceed as follows should you need to restart the PosterJet Server while it is being 
hosted under the IIS.  
 

1) Open the Windows command window by using the option “Run as Administrator”.  
 

 
 
Type the following Windows command and hit the Enter key from your keyboard: 
issreset 
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The following window appears once the IIS has been restarted successfully.  
 

  
 
Important notice: never restart the IIS using this option, if other services 
are hosted by the IIS too (e.g. Outlook Exchange Server). Otherwise, all 
services are terminated and restarted! 
 

2) A different method for restarting just the PosterJet Server when being hosted 
under IIS is to only stop and then restart the PosterJet Application Pool. Proceed 
by first opening the computer management.  
 

 
 
Go to „Application Pools“ and select the „PJServer80“. Stop the Application Pool 
„PJServer80“ and then start it again.  
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PosterJet parameters for Internet Information Services 
 
In order for the PosterJet Server to work without issues under the IIS it is important that 
the following parameters are set correctly. Basic settings for the “PJServer80” 
Application Pool. 
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Advanced settings for the “PJServer80” Application Pool.   
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Basic settings for “PJServer80” Default Web Site. 
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Advanced settings for the “PJServer80” Default Web Site. 
 

 
 
The following method can be used to check if the PosterJet Server was correctly 
installed and registered under the IIS: Open the Microsoft „Internet Explorer“ and type 
the following address into the address bar: 
 
http://localhost/PJServer80/PJServerV8.asmx 
 
You PosterJet Server was correctly installed and registered under the IIS if the following 
window appears:  
 

 
 

71



 

 

Date 01.10.2015

Support Guide 
No. 19 

 
Your PosterJet Server was incorrectly installed or registered under the IIS if the folowing 
window appears: 
 

  
In such case check the parameters for the „PJServer80“ Application Pool and Default 
Web Site. 
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PosterJet 8.7 and Kaspersky Internet Security Suite 
 
In order to enable a trouble free and real time communication between PosterJet Client 
and PosterJet Server it is important that you follow the instructions carefully when using 
Kaspersky Internet Security Suite on the same computer. Using different malware 
protection software may require adding similar exceptions for PosterJet.  
 
First open Kaspersky Internet Security Suite. Select “Settings” from the top menu. 
 

 
 
Open the Firewall  menu and click onto the button “Settings…”. 
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Kaspersky Internet Security Suite will place PosterJet Client and Server typically into the 
area of “Low Restricted ” applications. In order to enable a trouble free communication 
between the PosterJet components and for reasons of performance it is required that 
PosterJet is added to the group of trusted programs. Here is how to change the status: 
  
Right click on the entry PosterJet Admin Tool  and select the menu item „Trusted “ from 
the context menu as seen in the following screenshot. 
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Repeat the step for the following component: PosterJet Application (if available also 
eABAPI Core Process module  and Canon IOS Core Module) , so that subsequently all 
components can be found in the group of trusted applications. 
 
 

 
 
 
 
Hint : ensure that you add PosterJet Client and Server to the exception list when using 
different antivirus software in order to ensure real time communication between the 
components. 
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Reproduction of PDF-files with overprinting elements 
 
PDF files with elements set to overprint may in some cases output incorrectly. The 
overprint information may just be ignored by PosterJet or rendered incorrectly. In order to 
reproduce such documents correctly we suggest you proceed as follows. 
 
Requirement: a virtual PosterJet printer must be installed. The installation of a virtual 
PosterJet printer is described in Support Guide No. 5. 
 

1) Load and install Acrobat Reader X (at least in version 10.1.2). 
2) Open the PDF file and click the print symbol. 

 

 
 

Select the “by PosterJet” printer from the printer list. Click the „Advanced“ button 
and activate the option „Simulate Overprinting“. 

 

 
 

Now confirm with „OK“. If required, set optional parameters under “Properties”. 
Click „Print“ to send the file directly into the PosterJet queue for processing and 
printing. 
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PosterJet Tri-Side-Cut (TSC) plugins 
 
Using the PosterJet TSC plugins will help you reduce time while trimming images to 
obtain borderless results. Every time you print an image that is smaller than the current 
roll width, you end up having borders around your print. The TSC plugins allow you to 
print smaller images effectively onto any roll paper, having to cut only one side in order to 
obtain a fully borderless output. It's necessary to understand the functionality of TSC 
plugins in order to avoid any errors, so please read the following explanations carefully. 
 
Features: 
 
A PosterJet TSC plugin is handled as a dedicated printer in PosterJet. This means: a 
Canon iPF6100 plugin and the iPF6100 TSC plugin are handled the same way in 
PosterJet both requiring a printer license. The simultaneous use of a standard printer 
plugin and a TSC plugin in PosterJet requires a SimuPrint license for the “second” 
printer. 
 
A TSC plugins prints at least three sides of an image borderless so that only one side 
must be cut manually to achieve a complete borderless print (the standard PosterJet 
printer plugin or even the original Canon printer driver only print borderless when the 
image is scaled to the full media width).  
 

 
 
 
This functionality is very useful when: 
 

A) Printing images smaller than the current roll width and having to cut only one side 
to obtain a fully borderless result. 
  

B) Printing tiling jobs that require no trimming - completely borderless (e.g. Wallpaper 
printing). Using the TSC plugins you can print oversize wallpapers completely 
borderless with pixels matching accurately from tile to tile. 
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Example of borderless job using the tiling option 
 

 
 
 
Requirements for the use of Tri-Side-Cut plugins: 
 

- A working PosterJet 8.7 installation is required. 
 
- A TSC plugin must exist for your printer. These specialized plugins are available for 

a number of Canon iPF-printers only. A list with available TSC plugins can be found 
at the end of this document.  

 

- Before installing the TSC plugins you must update the standard PosterJet printer 
plugin for the respective printer using the PosterJet “Printer and Media Update”. 

 

- When printing single images (no tiling jobs) PosterJet will automatically add 3mm to 
the sides overlapping the paper so that you always obtain an output in the size 
provided (e.g. you set the output size to 10” x 15” and you obtain a borderless print 
in the size of 10” x 15”).  

 

- TSC plugins use media profiles of their own which are not compatible to the profiles 
of standard printer plugins. The media profiles of the standard plugins are not 
compatible to the TSC plugins either. Media profiles for all printers are available 
through the PosterJet “Printer and Media Update” utility from within the Client 
interface. 
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- Jobs to be printed with the TSC plugin must have a height of minimum 20 cm (or 7.9 
inches) to successfully print borderless on 3 sides. This minimum length is part of a 
setting in the Canon iPF-printer and cannot be changed. 

 

 
 
 

- The roll width must match the specifications for borderless printing on the respective 
Canon printer. Canon iPF-printers do not allow borderless printing on any roll width, 
but just on a few specified sizes. The roll width must not differ even slightly from the 
specified width. Printing onto a roll that is not approved for borderless printing will 
lead to a print with standard borders. 

 
Further limitation: borderless printing onto a 60 inch roll with a 60 inch Canon iPF 
printer is - by default - not possible. 

 
- Do not activate the check box "Borderless printing" within the PosterJet job 

submission window when using the TSC plugin. The option is set automatically by 
PosterJet. 
 

- The tiles of a borderless tiling print job will perfectly fit to one another other if you 
add an overlap of 6mm or 0.24 inches to “Vertical join” (option inside “Tiling” tab of 
the PosterJet job submission window). 
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TriSideCut plugins are available for the following printers only: 
 

- Canon iPF6100 
- Canon iPF6300 
- Canon iPF6350 
- Canon iPF6400 
- Canon iPF6450 
- Canon iPF6400s 
- Canon iPF8000 
- Canon iPF8000s 
- Canon iPF8100 
- Canon iPF8100s 
- Canon iPF8300 
- Canon iPF8300s 
- Canon iPF8400 
- Canon iPF8400s 
- Canon iPF9100 
- Canon iPF9400 
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Profile creation with Canon SU-21 Spectrophotometer 
 
 
A) Creating a Custom Media using Media Configuration Tool © 
  
For the creation of PosterJet media profiles the user can either choose standard 
(available in printer) or custom media settings (to be created by user) on the 
printer front panel of the Canon iPF-printer.   
 
Section A describes how custom media settings (mostly for 3rd party media 
where standard settings do not deliver a satisfying result) can be created for 
one of the new Canon 12 color iPF-printer (x400-series) and also be transferred 
to another iPF-printer of that same series. The Media Configuration Tool© 
enables the creation, administration and transfer of custom media profiles on 
compatible Canon printers. The following printers allow the exchange of 
PosterJet media profiles by granting identical results on any of the listed 
printers: 
  
iPF6400 / iPF6410 / iPF6450 / iPF6460  
iPF8400 / iPF8410  
iPF9400 / iPF9410 
 
 
Proceed as follows: 
 
After the installation of the Media Configuration Tool© open the program via the 
windows start menu or the desktop shortcut. 
 

 
 
Choose the option „Add and Edit Custom Paper“. 
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Choose a Printer from the dropdown menu and click „Next“. 
 
 

 
 
 
Now you can either add or import an existing custom media profile. To add a 
custom media click now on „Add“. 
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Adding of a custom media types is subdivided into several steps: 
 
 

 
 
 
Step 1: Choose the media type and the media type name and click on „Next“. 
 
 

 
 
 
Step 2: Set the name of the custom media and click on „Next“. Please note that 
the maximum length of the name is limited to 16 characters. If more than 16 
characters are entered, a warning message will appear. 
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Load the roll paper and choose the category „Custom“ in the printer front panel 
where you will find the newly created media type. Proceed with „OK“. 
 
 

 
 
 
Step 3: Choose the paper source and click on „OK“. 
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Step 4: If required the paper feed adjustment can automatically be executed. 
If you want to skip this step click directly on „Next“. 
 
 

 
 
Choose the roll paper settings and confirm with „Next“. 
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Step 5: If required the amount of ink usage, the printer head height and the 
vacuum strength can now be configured. If you want to skip this step click 
directly on „Next“. 
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Select the necessary options (see screenshot above) and click „Start Print“. 
 

 
 
 
An information window with the selected settings pops up. Start printing by 
clicking on „OK“. 
 
 

 
 
 
After an appropriate drying time check the printed paper and choose the test 
field with the best print result. Choose the corresponding setting in the open 
window and confirm with „OK“. 
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Step 6: Confirm the settings for the custom media and click on „Next“. 
 
 

 
 
 
Now confirm the update of the printer control panel and the printer driver. Click 
on „Execute“. 
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After the update you will be informed about the possibility to create a calibration 
target. Click on „OK“. 
 
 

 
 
 
Now, in the custom media overview the newly added media will be displayed. 
Finally, you should create a calibration target for your custom media (not 
available for all media types) by clicking „Create Calibration Target“. 
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Confirm that you with to create a calibration target and click „Execute“ 
 
 

 
 
 
After the paper feed adjustment is executed automatically the calibration target 
will be created. In the end an information window pops up. Now click „OK“. 
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Apply the registration of the calibration target in the printer and the printer driver. 
Click on „Execute“. 
 
 

 
 
After the calibration target has successfully been created you can export the 
custom media profile (including the calibration target). 
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B) Export Calibration Target using Media Configuration Tool © 
 
This section describes how an existing calibration target can be exported to a 
compatible printer, using Media Configuration Tool©. 
 
 
 
Proceed as follows: 
 
If you have already installed Media Configuration Tool open the application via 
the windows start menu or the desktop shortcut. 
 

 
 
Choose the option „Add and Edit Custom Paper“. 
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Choose a printer from the dropdown menu and click „Next“. 
. 
 

 
 
 
Choose your custom media and click „Export“. 
 
 

 
 
 
Now you can export the custom media information as a media information file 
(*.am1).  
To do so, please choose a destination folder and click „OK“. 
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After the *.am1 file has successfully been saved a confirmation window 
appears. Click „OK“ once again to finalize the export. The *.am1 file can now be 
selected and imported to another iPF-printer (x400-series). 
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C) Import Calibration Target Using Media Configuration Tool © 
 
This section describes how a custom media profile can be imported into a 
compatible iPF-printer using the Media Configuration Tool©. 
 
 
Proceed as follows: 
 
Run the Media Configuration Tool©. 
 

 
 
 
Choose the option „Add and Edit Custom Paper“. 
 
 

 
 
 
Choose a printer and click „Next“. 
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To import a custom media click the „Import“ button. Please note : in the 
following example we chose a different media for export than the one in the 
previous chapters (SatinPhoto240g instead of SpecBlueBack130). 
 
 

 
 
 
Choose the media information file (*.am1). Next to the file name, the date and 
media type is shown in the window. Just click „Next“. 
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Choose a target for the update and click „Execute“. 
 
 

 
 
 
Once the custom media has successfully been imported it will show up in the 
Add and Edit Custom Paper window. 
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D) Create a PosterJet Media Profile based on a Standard Media Type using  
     Canon SU-21 Spectrophotometer. 
 
Using the Canon iPF6450 in combination with SU-21 spectrophotometer 
enables the user to create color profiles for any media. Note that the SU-21 
spectrophotometer is only available as an option. 
 
 

 
 
Proceed as follows: 
 
First install a measurement device plug-in in PosterJet by opening the PosterJet 
Media Manager. 
 

 
 
Select „Media update…“ from the “Tools“ menu. If you have no internet 
connection, please proceed as follows, otherwise select the PosterJet 8.6.1 
official Update Service to download and automatically install the SU-21 
measurement plug-in. 
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Select the radio button „Update from file“ (when Update Service is not available) 
and click „Browse“. 
 
 

 
 
 
The plug-in for the Canon SU-21 spectrophotometer is located in the following 
folder on your PosterJet Installation-DVD: 
 

\\Extras\PJ Measurement Device Plugins\CanonSpectroSU21.zip 
 
Choose this file and click „Open“. After the installation of the plug-in software 
the active window can be closed. 
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Now select the option “Select measurement device…“ from the „Tools“ menu. 
 
 

 
 
 
After the plug-in has successfully been installed the corresponding device 
should appear in the overview (as above). Choose „Canon Spectro SU-21“ and 
click on  „OK“. 
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The selected measurement device is now shown in the lower right corner of 
Media Manager window. 
 
To profile of a standard media load the roll paper in the printer as described in 
the printer manual and choose the corresponding media type from the printer 
front panel (console). 
  
To create a color profile, please follow the instructions in Support Guide No. 13. 
 
Please note that PosterJet controls the printing and measurement process 
automatically so you only have to click „Next“ at all time in the Profiling Wizard. 
 
Important: creation of new media profiles in PosterJ et is only available 
with active “Linearization” or “Profiling” module in PosterJet! 
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E) Create a PosterJet Media Profile based on custom media type settings 
    using Canon SU-21 Spectrophotometer 
 
After the creation / import of a custom media type (media information file *.ami1) 
using Canon Media Configuration Tool© into your printer, PosterJet 8.6.1 is now 
ready to use the new media setting in order to create an ICC-profile based on 
the new paper parameters.  
 
 
Proceed as follows to dynamically create a new media type in PosterJet (e.g. 
Custom_GP240g): 
 
Please load the roll paper by selecting the newly created / imported media 
setting from the printer front panel (e.g. Custom_GP240g for your custom 
Glossy Paper). The so called “extended media type” number (in brackets) is 
shown in the PosterJet 8.6.1 „Media Settings“ tab. You will need this number 
later (here 0xFF01).  
 
Hint: 
 
This “extended media type” is only shown for a selected custom media. 
 
 

 
 
 
Now open PosterJet Media Manager from the Tools menu. 
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Now create a new media profile by clicking on the Plus-button (see Support 
Guide No. 13). Make sure the original clone settings (Standard Paper) that were 
used for profiling the custom paper in the printer are selected here too. 
Example: in the Media Configuration Tool© the setting “Glossy Photo 240g” was 
used to create our “Custom_GP240g” custom media profile. For the creation of 
the PosterJet media profile the “Standard Paper” setting from Media 
Configuration Tool (here “Glossy Photo 240g”) must now first be selected. 
 
 

 
 
Once the media profile (not ICC-profile) has been created you must change the 
“MediaExt Type” in the Media Manager (here from 0x014d to 0xFF01). For this, 
please click on the paper name in the left part of the window and press the F5 
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key. Repeat this procedure in order to enter the editing mode in the right part of 
the window (see screenshot below). 
 

 
 
 
In the editing mode the media extended type (MediaExt Type) is shown. Please 
insert the Extended Type (exactly as shown in “Media Settings” tab) in the field 
“MediaExt Type” and confirm by pressing Enter on keyboard (see screenshot 
below). 
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Using this setting will enable PosterJet 8.6.1 to print profiling test charts or, at a 
later stage, all jobs based on the select printer media type settings (ensuring 
perfect output quality). 
 
 

 
 
 
To avoid any later confusion with similar profiles in PosterJet change the name 
under “Media Type” – see screenshot above. 
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F) Measuring a test chart printed on any large format printer using Canon 
SU-21 Spectrophotometer 
 
The optionally available Spectrophotometer SU-21 enables the measurement of 
test charts that were printed on any other large format printer, not iPF6450. The 
following chapter describes how to print a special test chart for example on 
Canon iPF9400 and thereafter measure it on a Canon iPF6450 with SU-21 
Spectrophotometer. From the measurement data obtained by the SU-21 an 
ICC-profile will be generated using PosterJet 8.6.1 and finally imported for the 
use with the original Canon iPF9400. 
 
Proceed as follows: 
 
Please load the paper roll in the printer of your choice (e.g. Canon iPF9400) and 
select the corresponding media type on the printer front panel. Now open the 
PosterJet Media Manager and create a new media profile for this printer (see 
Support Guide No. 13). 
 

 
 
 
Important:  Do not change paper feed adjustment or other length affecting 
parameters as the test chart may otherwise not be measured correctly on the 
Canon iPF6450. A paper feed adjustment may be useful, because a correct 
paper feed is necessary for measuring the test chart (see Printer Manual). 
 
Now follow the instructions to print the special PosterJet test charts with the 
name 
 
Linear Printfile Universal Printer SU21 (XOrder).tif 
for media with roll width smaller/equal 24" (610 mm) 
 
or 
 
Linear Printfile Cutout Universal Printer SU21 (XOrder).tif 
for media with roll width greater 24" (610 mm) 
 
Unless stated otherwise the following text refers to the test chart for roll media 
smaller/equal 24": 

106



 

 

Date 10.01.2015

Support  Guide  
No. 23 

 
Once you have selected the new media in the “Media Settings” tab click on  
„Add files to main queue“ (Icon with Plus symbol). 
 

 
 
The necessary test chart file is located on the PosterJet DVD in the folder  
 

<<drive>>:\Extras\Testcharts\ 
 
Choose this test chart file and click on “OK”. 
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Important : make the following settings in the Job Submission Window in the 
order described below: 
 

- In the “Layout” tab ensure that scaling is set to 100%. 
- In the „Color“ tab make sure that „Color Correction“ is set to „Linear ”. 
- Deactivate automatic cutting after the job has been printed. To do so 

remove the checkmark for the field “Cutter” in the “Printer” tab. Hint: if 
media is used with a roll width greater than 24" the cutter can remain 
switched on. 

 
After editing the settings please click on “Submit Job” (Button with green 
checkmark). 
 
 

 
 
 
After an appropriate drying time eject the roll paper leaving the output on the 
roll  (that is why we recommend that you use a 24” roll). 
 
Important:  At the beginning of the roll paper a black cutting line is printed along 
the paper width (scissors symbol). Please cut away the first part of the paper by 
cutting the paper clean and straight along this line. 
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Hint for roll media greater than 24":  After printing the “Cutout” version of the 
chart please cut it from the roll and cut along the complete borders. 
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Now load this previously printed roll paper in the correct direction (printed paper 
shows in your direction) into the Canon iPF6450 using the option “Load Roll” 
(NOT cut sheet ). Select any media type on the printer front panel (not 
necessarily the corresponding one) and wait until printer is ready. 
 

 
 
Hint for roll media greater than 24":  Please load this test chart as "Roll 
Media" into your printer, too. Please take care of the correct position. 
 
Go to the “Tools” menu in PosterJet and choose the option “Select 
Measurement Device“. In the list of devices choose the “Canon Spectro SU-21” 
and click on “OK”. If the measurement device is not available please follow the 
instructions in Support Guide No. 29 section D. 
 
Now create a new media profile in PosterJet using the Canon iPF6450 (see 
Support Guide No. 13). To do so, switch to Canon iPF6450 as active printer and 
open the media manager and create a "DUMMY MEDIA". For further 
information please check Support Guide No. 13.  
 
Hint:   The transfer of the later calculated ICC-profile to the iPF9400 will be 
explained later  in this document. Please note that both test charts were 
made only for RGB  profiles, so you have to choose the "RGB-Contone" mode 
(see below). 
 
 
 
 

110



 

 

Date 10.01.2015

Support  Guide  
No. 23 

 
 
 
Creating a new “Dummy Media” in PosterJet using the Media Manager (quick 
version ): 
 
Step 1 : Create a new media pressing the "Plus”-button in the PosterJet Media 
Manager. 
 

 
 
 
Step 2 : Click on "Next" to start the Wizard. 
 
Step 3:  Enter the name of the media and choose the media typ. Now click 
"Next". 
 

 
 
Step 4:  Choose “Contone RGB” under Dithering and select Resolution and Print 
quality. We recommend you to select Fine (600x600dpi) and Normal. 
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Step 5:  Choose the test chart Universal Printer SU21 (XOrder).txt from the drop 
down menu. 
 

 
 
 
Now click on „Print testchart“. Ensure that the PosterJet main queue is started 
so that the print can be performed quickly. This test chart will actually just 
forward the already printed paper to the correct position for the measurement, 
without printing anything onto the paper.  
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Step 6 : The correct position of the pre-printed test chart can be controlled by 
opening the top cover and ensuring that the fine line seen in this pictures is 
currently placed right in front of the roll holders. 
 

 
 
Enlarged image (see fine line) 
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Step 7 : Once the “printing” is complete and you have checked the position of 
the paper, click “Next” to start with the measurement of the colour patches. 
PosterJet will display a message as soon as the measurement is completed. 
Click “Next” to move to the next step. 
 

 
 
 
Step 8: Select „Balance black point“ and „Compensate fluorescence“ if 
required. The switch for correcting optical brighteners will only appear, if the 
measurement has found them in the paper. Click “Next” to finalize the profile 
creation process. 
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Step 9: Enter a new name or use the default name for your new profile. We 
recommend that you chose a unique name, so there will be no confusion at a 
later stage. Click on “OK” to start the calculation. 
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Step 10 : After the successful creation of the profile a summary appears. 
 

 
 
Now click on “Finish” to complete the process. Your profile has automatically 
been copied to the “DUMMY MEDIA” folder. 
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In order for PosterJet to use this new profile together with the original printer, it 
is necessary to import the ICC-profile to the corresponding media and print 
quality of our original printer (here: iPF9400). To do so, please open the 
Windows Explorer and copy the ICC-profile on the Desktop (or any other 
location of your choice). 
 

 
 
Newly generated ICC-profile can be found in the Canon iPF6450 PosterJet 
printer folder located at: 
 

C:\Programme\Eisfeld Datentechnik\PosterJet V8 Admin Tool\ 
wwwroot\PJServer80\App_Data\Printer\Canon_iPF6450\ 

 
Now switch back to the original printer in PosterJet (here: Canon iPF9400) and 
open the Media Manger. 
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Open the media tree. Select the print quality and click with the right mouse 
button to open the context menu. Choose “Change ICC profile…” to import your 
new ICC-profile. Note: the ICC-file will automatically be copied into the 
corresponding iPF9400 Printer/Media folder and connected to the print quality.  
 
The following window will open. 
 

 
 
Select the previously saved ICC-profile and click “Open”. 
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The imported ICC-profile is shown under “ICC” in the Media Manager 
information window. If you are now printing with PosterJet using this media and 
print quality, exactly this ICC-profile will automatically be used for every 
upcoming print job. 
 
Hint:  After the import of the measured test chart to the original printer the 
folder of the  "Dummy Media" for the iPF6450 can be deleted to prevent any 
later confusion. 
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Database backup and restore 

PosterJet settings and templates are stored in a database. If you wish to backup all 
PosterJet parameters, including installed printers, templates, hot folders, Client settings, 
and many more, we recommend you perform a backup of the PosterJet database. 

A defective database can lead to PosterJet Server issues (Server not starting). In such 
cases it can be useful to have a working backup of the database file in order to repair 
PosterJet.  

Method 1: for operation of PosterJet under V8 Hosting 

Open the interface of the PosterJet Administration Utility 

 
 
Make sure no jobs are currently processed or printed by PosterJet before you stop 
the Server by clicking the „Stop“-button. 
 

 
 

Windows status bar with active 
applications. Click PosterJet 
Administration Utility twice in 
order to open the interface. 
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Two new tabs appear. Click the „Backup” tab. 
 

 
 
Now click the button „Backup Database“. An explorer window opens. Accept or 
change the suggested name for the backup file and click the “Save”-button. 
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Terminate the procedure by a click on the „OK“ button. 
 

 
 
Finally, do not forget to restart the PosterJet Server by a click onto the „Start“ 
button. 
 

 
 

  

 

 

 

122



 

 

Date 10.01.2015

Support Guide 
No. 24 

 

Restore the PosterJet database by following the same procedure as described above, 
but with the difference that you select the button “Restore Database” instead of “Backup 
Database”.  Chose the backup file you wish to restore and click „Open“. 

  

Once completed click the „OK“ button to finalize the restore procedure. 

 

 

Hint:  After a restore PosterJet hot folders only reappear, if the Client ID remains 
the same as the one that was used during the setup of these folders. You 
find the Client ID in the file „PosterJetClient.ini“ located in the following 
folder (you may have to backup the ID as well): 

C:\Users\<current user>\AppData\Roaming\Eisfeld Datentechnik GmbH & Co. KG\ 
PosterJet 8.7\8.7.5723.15896\ 
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Method 2: for operation of PosterJet under Windows IIS 

We recommend a different method for a database backup and restore if PosterJet is 
operated under Windows Internet Information Services (IIS). Please open the application 
„pgAdmin III“ under the Windows Start menu entry „PostgreSQL 9.4“. 

 

Open the PosterJet database by double clicking the entry „PostgreSQL 9.4 
(localhost:5432)“ in the window „pgAdmin III“. 
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Click „OK“ once you have entered the password. Start the database backup by right 
clicking the entry „PosterJetDB“ and select the option „Backup…“ from the context menu. 

 
 
A new window will open. Click the button with the 3 dots in order to enter a name for the 
backup file (here: Backup_25-10-2015). Then click the “Save” button to save the 
database backup file. 
 
 

Enter the password and 
continue by clicking the “OK” 
button. The password for the 
PosterJet database is: 
PosterJet    (case sensitive). 
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Now click the „Backup“-button that became visible to complete the process. 
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A successful backup is show by an Exitcode = 0. Terminate the backup process by 
clicking the „completed“-button and close the application „pgAdmin III“. 
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If you wish to restore a PosterJet database, whether completely empty or from an 
existing backup file, proceed as follows: open the application „pgAdmin III“. Enter the 
password to open the PosterJet database. Right click the entry „PosterJetDB“ and select 
the option „Restore“ from the context menu. 

 

Click the button with the 3 dots in order to select a backup file. Click the “Restore”-button 
to restore the database from the selected backup file. 
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HINT: select the file „PosterJetDB_Blank.backup“ from the list in order to create a new 
and empty database (same status as after the very first installation of PosterJet). 
 
Once you have selected a file click the “Restore“-button. 
 

 
 

Open 
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The database restore is successful if the message „process terminated with Exitcode 0“ 
appears. Complete the restore by clicking the „Ready“-button and close the application 
„pgAdmin III“. 
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Method 3: removing an existing database and create a complete new configuration 
 
If the PosterJet Server can’t be started it is highly probable that the database file was 
corrupted during operation and needs to be replaced. In some cases, restoring an 
existing database file with a backup or empty file will fail, because the current database 
needs to be removed first. Please proceed as follows to remove the current database so 
that you can either restore a backup file or the blank database file included in the 
PosterJet installation. 

Please open the application „pgAdmin III“ under the Windows Start menu entry 
„PostgreSQL 9.4“. 

 

Open the PosterJet database by double clicking the entry „PostgreSQL 9.4 
(localhost:5432)“ in the window „pgAdmin III“. 
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Click „OK“ once you have entered the password. Start the database backup by right 
clicking the entry „PosterJetDB“ and select the option „Delete/Drop…“ from the context 
menu. 

 
 
Confirm that you wish to delete the database file by clicking “Yes”. 

 

Enter the password and 
continue by clicking the “OK” 
button. The password for the 
PosterJet database is: 
PosterJet    (case sensitive). 
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Create a new PosterJet database by selecting the option “Databases (1)” from the 
pgAdmin III Object browser window using the right mouse. Now select the option “New 
Database…” from context menu. 

 
 
Enter “PosterJetDB” as the name for the new database and select “PosterJet” from the 
drop down menu under Owner. The confirm with a click on the “OK”-button. 
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Click the button with the 3 dots in order to select a backup file. Click the “Restore”-button 
to restore the database from the selected backup file. 

  

Either chose an existing file in order to restore a previous setup or chose the file  
“PosterJetDB_Blank.backup” to restore a new and completely empty database. Click the 
“Open”-button once you have selected the appropriate file.  
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Once you have selected a file click the “Restore“-button. 
 

 
 
The database restore is successful if the message „process terminated with Exitcode 0“ 
appears.  
 
 
 
 
 

Open 
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Complete the restore process by clicking the button „Done“ and close the application 
„pgAdmin III“. Restart PosterJet Server and Client. 
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The PosterJet Tool Ver2 
 
This tutorial explains the functionality of the new “PosterJet Tool Ver2” (henceforth called 
“PJ Tool”) and how to use it correctly. We developed the tool to facilitate certain 
processes, which may become necessary after the installation of PosterJet. 
 
The newest version of the PJ Tool can always be found on our website www.posterjet.de. 
 
The PJ Tool consists of only one window, which is separated into three areas: 
 

1. The top part helps you to grant administrative privileges (permissions) to the 
installed virtual PosterJet printer(s). 

2. The middle helps you to install an IIS (Internet Information Service) on your 
computer (recommended for PosterJet installations under Windows Server OS). 

3. At last the bottom part of the interface will automatically set configuration 
parameters for PosterJet to any installed IIS. 
 
 

 
 
 
 
 
 

137



 

 

Date 10.01.2015

Support Guide 
No. 25 

 
Granting permissions to virtual PosterJet printer 
 
At least one virtual PosterJet printer must be installed under Windows before you can set 
the permissions (see chapter explaining installation of a virtual printer or also called 
PPD). Necessary permissions must be set in order to guarantee the trouble-free 
operation since PosterJet virtual printer (PPD) come without digital signature. First close 
PosterJet Server and Client. Select the PosterJet virtual printer from the drop down menu 
and click the button “PPD / PosterJet” to set the necessary permissions. Wait until 
procedure is completed and reboot the PC. 
 
Hint: Under Windows 8 and Windows 10 the installation of unsigned printer drivers is 
blocked by the operating system. Please check the Microsoft Support website for help on 
how to install unsigned drivers und Windows. 
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Setup Windows Internet Information Services (IIS) 
 
If you wish to run PosterJet with help of the Microsoft Internet Information Service instead 
of the normal PosterJet Hosting Service, you first will have to install the IIS on your 
system. 
 
Attention: On server systems, for example like Windows Server 2012 R2, you will have to 
add specific “roles” to the server in order to add the IIS. To do so, please use the Server 
Manager or get in touch with your network administrator. 
 
To install the IIS on a Windows 7 or Windows 8 system please follow these steps: 
 

1. Exit all PosterJet applications (Admin Tool and Client) on your computer. 
2. Start the PosterJet Tool Ver2 as administrator (right click � “run as 

administrator”). 
3. Choose the option “IIS Activate” from the “IIS” section of the window. The tool will 

now install the IIS and its required components on your system. This may take a 
few minutes. Please restart your computer as required once the procedure is 
terminated. 

 
The IIS is now installed on your computer, but not yet connected with PosterJet. To do 
this, please proceed with the next step as described under “Register PosterJet under IIS 
and grant permissions”. 
 
 
Register PosterJet under IIS and grant permissions 
 
In order to register PosterJet under the IIS, a few parameters have to be set under 
Windows. It is also very important that PosterJet is granted the necessary permissions to 
function properly under the IIS. The PJ Tool will set these parameters for you. Please 
note that other applications using the IIS stay untouched. Only the newly added 
“PosterJet application pool” will be altered. 
 
To start the process, please proceed as follows: 
 

1. Close PosterJet Server and Client. 
2. Start the PosterJet Tool Ver2 as administrator (right click � “run as administrator”) 
3. Click the button “IIS / PosterJet” in the “IIS / PosterJet” section. The tool will now 

register PosterJet under the IIS and set all necessary permissions automatically. 
The procedure may take a few minutes. Please restart your computer again as 
required once the procedure is terminated. 

 
After rebooting the PC, open the PosterJet Administration Utilities and switch the option 
under Hosted on “PosterJet V8 Hosting” to “Internet Information Services (IIS)” while the 
PosterJet server has been stopped. Save the changes by selecting the option “Save 
Settings” from the menu “Server”. PosterJet is now hosted as a service under the IIS, 
which enables the use of the PosterJet Server without being logged-in to your PC. 
Finally, remove the application “PosterJet Admin Tool” from the Windows Autostart 
menu, as it is no longer required. 
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Disclaimer 
 
Eisfeld Datentechnik assumes no liability or responsibility for any errors or omissions in 
the content of these documents. Your use of this Support Guide is at your own risk. 
Under no circumstances and under no legal theory shall Eisfeld Datentechnik, be liable to 
you or any other person for any indirect, direct, special, incidental, or consequential 
damages arising from your access to, or use of, these documents. 
 
All copyrights are held by their respective owners, unless specifically noted otherwise. 
Use of a term in this document should not be regarded as affecting the validity of any 
trademark or service mark. 
 
Naming of particular products or brands should not be seen as endorsements. 
 
You are strongly recommended to take a backup of your system before major installation 
and backups at regular intervals. 
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